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HSD High Speed Data Acquisition 

General Description 

The high-speed data acquisition system consists of a DT321 PCI board and a 

terminal box. The system allows acquisition with a resolution of 16 bits of 8 

analogue inputs in the range of +/-10V at a frequency up to 250 kHz. 

Installation 

The software for the DT321 board needs to be installed in the computer by 

performing the following steps. 

1. Insert the Data Acquisition OMNI CD into your CD-ROM drive. If the Data Acquisition 

Software set-up program starts automatically proceed to step 4. 

2. Click Start from the Task Bar, then click Run. The Run dialog box appears. 

3. In the Command Line edit box, enter X:\LAUNCH.EXE (where X is the letter of your CD-

ROM drive). Click Ok. The Data Acquisition Software set-up program starts. 

4. Click Install Products. A list of software products that you can install appears. 

5. Click Device Drivers. The DT-Open Layers Data Acquisition software wizard appears. 

6. Click Next. You are then prompted to provide the destination location. 

7. Change the directory path and/or name using Browse or accept the default directory, 

then click Next. 

8. You are prompted to select the software components to install. 

9. Select DT300 Series then click Next. 

10. You are prompted for the program folder name. 

11. Change the program folder name or accept the default program folder name, then click 

Next. 

12. The files are copied to the destination directory. 

13. Click Finish. The DT Data Acquisition Software set-up program reappears. 

14. Click Main Menu. 

15. Click Exit. 

Once the software has been successfully loaded, the DT321 board can be fitted 

inside the computer.  

1. To set up the computer, perform the following steps: 

2. Turn off the computer. 
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3. Turn off all peripherals (printer, modem, monitor, machine and control cabinet) 

connected to the computer. 

4. Unplug the computer and all peripherals. 

5. Remove the cover from you computer. Refer to your computer’s user manual for 

instructions. 

Once you have set up the computer, set up an expansion slot by performing the 

following steps: 

1. Select a 32-bit or 64-bit PCI expansion slot. PCI slots are shorter than ISA or EISA slots 

and are usually white or ivory. Commonly, three PCI slots (one of which may be a 

shared ISA/PCI slot) are available. If an ISA board exists in the shared slot, you cannot 

use the slot for a PCI board. If a PCI board exists in the shared slot, you cannot use the 

slot for an ISA board. 

2. Remove the cover plate from the selected expansion slot. Retain the screw that held it in 

place; you will use it later to install the board. 

Once you have set up an expansion slot, perform the following steps to insert 

the DT300 Series board into the computer: 

1. Discharge any static electricity by holding the wrapped board in one hand while placing 

your other hand firmly on a metal portion of the computer chassis.  

2. Carefully remove the antistatic packing material from the board. (It is recommended 

that you save the original packing material in the unlikely event that your board requires 

servicing in the future.) 

3. Hold the board by its edges and do not touch any of the components on the board. 

4. Position the board so that the cable connectors are facing the rear of the computer, as 

shown: 

 

  



 - 3 - 

5. Carefully lower the board into the PCI expansion slot using the card guide to properly 

align the board in the slot. 

CAUTION: DO NOT FORCE THE BOARD INTO PLACE. MOVING THE BOARD FROM 

SIDE TO SIDE DURING INSTALLATION MAY DAMAGE THE BUS CONNECTOR. IF 

YOU ENCOUNTER RESISTANCE WHEN INSERTING THE BOARD, REMOVE THE 

BOARD AND TRY AGAIN. 

6. When the bottom of the board contacts the bus connector, gently press down on the 

board until it clicks into place. 

7. Secure the board in place at the rear panel of the system unit using the screw removed 

from the slot cover. 

8. Power up the computer. 

If you installed the DT300 Series software (as described above), the DT300 

Series device driver is automatically loaded. If you have not installed the 

software, ensure that you do so now. 

Once you have installed the DT300 Series driver from the Data Acquisition 

OMNI CD, installed a DT300 Series board, and powered up the host computer, 

the New Hardware Found dialog box appears. Perform the following steps to 

load the device driver in Windows XP: 

1. Click Next. 

2. Click Search for a suitable driver for my device (recommended). 

3. Click Specify a location, and click Next. 

4. Browse to Windows/System32/Drivers/DT300.Inf, then click Open. 

5. Click Ok. 

6. Click Next. The files are copied. 

7. Click Finish. 

8. Open the Control Panel. 

9. Double-click the Open Layers Control Panel icon. 

10. Select the DT300 Series board to configure, then click Advanced. By default, the prompt 

“Handles Overloaded Bus?” is checked. 

11. When you are finished, click Close. 

Finally the DT321 board needs to be set-up in Control Panel to be able to 

communicate with COMPEND software. 

1. Open the windows Control Panel. 
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2. Launch the Open Layers Control Panel. The open layers control panel will be displayed on 

the screen. 

3. Left click on the board name to highlight it and click on Edit Name and change the name 

of the board to DT321. 

4. Click on Close. 

5. Close the Windows Control Panel. 

Setting up COMPEND for High Speed Data Acquisition 

The system is delivered with a COMPEND Installation CD. To install the software 

perform the following steps: 

1. Insert the COMPEND CD into your CD-ROM drive, if the installation software set-up 

program starts automatically proceed to step 5. 

2. Click Start from the Task Bar, then click Run. The Run dialog box appears. 

3. In the Command Line edit box, enter X:\install\setup.EXE (where X is the letter of your 

CD-ROM drive) proceed to step 8. 

4. Click Ok. The Data Acquisition Software set-up program starts. 

5. In the web page displayed Click Install. A window prompting if you want to save or run 

the program appears. 

6. Click Run. A window appears telling that the publisher is unknown. 

7. Click Run. The COMPEND installation window is displayed on the screen. 

8. Change the directory path and/or name using Browse or accept the default directory, 

then click Next. You are prompted to start the installation of the software. 

9. Click Next. 

10. When the installation is successfully finished press the Finish button to quit the 

installation software. 

If the installation CD is not supplied or if an existing COMPEND configuration 

needs to be modified to accommodate a high-speed acquisition system, 

COMPEND can also be set-up manually by doing the following. Firstly the 

COMPENDX.INI file has to be modified so that COMPEND detects the board at 

start up: 

1. Start COMPEND. 

2. In the Tools menu select System Files and click on INI File. The COMPENDX.INI file will 

then be displayed in the Windows Notepad. 

3. Using the mouse scroll down to [GROUP 15]. 

4. Enter the following parameters: 
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DEVICE_TYPE=DTHSD 

NUM_DEVICES=1 

NUM_ACTIVE=1 

COM_PERIOD=100 

COM_PORT=6 

COM_SPEC=BUSDEVICE  

5. In the File menu click on Save. 

6. Close the Notepad. 

7. Close COMPEND. 

Next time COMPEND is opened a box displaying DTHSD should be displayed in 

the COMPEND status bar. This box should have a green background. If this is 

not the case re-check that the data in the INI file were correctly changed. If the 

box is still not displayed or has the wrong background colour contact Phoenix 

Tribology for further assistance. 

Once the COMPEND INI file has been successfully modified the configuration file 

needs to be set up to display the high-speed control parameters: 

1. Start COMPEND. 

2. In the File menu select Edit Setup. The Setup mode should then be active and the 40 

boxes of the first page should be displayed on the screen. 

3. Using the Page Up or Page Down key find a page with 5 free boxes. 

4. Right click on the tile of the first box and select Properties. The properties window 

appears on the screen with the general properties displayed. 

5. Enter HSD Channels in the Description field, set the Units field blank then left click on 

the grey box opposite Box Colour and select the red colour and then click on Ok. 

6. Click on In Use. 

7. Click on the Connection tab. The connection properties are then displayed on the screen. 

8. On the left part of the window display scroll down and select DTHSD 1 then on the right 

part of the window select Channels as illustrated then click on Apply. Then click on the 

Calibration tab. 

9. The calibration properties will then be displayed on the screen: 
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10. On the calibration window enter 0 in Units Low and 8 in Units High then enter 0 in Bits 

Low and 8 in Bits High. Then Click on the Analogue Output Tab. 

11. The analogue output properties will then be displayed on the screen. 

12. On the Analogue Output window set Increment to 1 and Default Value to 1 then click on 

Ok.  

13. Right click on the tile of the second box and select Properties. The properties window 

appears on the screen with the general properties displayed. 

14. Enter HSD Frequency in the Description field, set the Units field to kHz then left click on 

the grey box opposite Box Colour and select the red colour and then click on Ok. 

15. Click on In Use. 

16. Click on the Connection tab. The connection properties are then displayed on the screen. 

17. On the left part of the window displayed scroll down and select DTHSD 1 then on the 

right part of the window select Frequency then click Apply. Then click on the Calibration 

tab. The calibration properties will then be displayed on the screen. 

18. On the calibration window enter 0 in Units Low and 250 in Units High then enter 0 in Bits 

Low and 250 in Bits High. Then Click on the Analogue Output Tab. The analogue output 

properties will then be displayed on the screen. 

19. On the Analogue Output window set Increment to 1 and Default Value to 1 then click on 

Ok.  

20. Right click on the tile of the third box and select Properties. 

21. The properties window appears on the screen with the general properties displayed. 

22. Enter HSD Samples in the Description field, set the Units field to blank then left click on 

the grey box opposite Box Colour and select the red colour and then click on Ok. 

23. Click on In Use. 

24. Click on the Connection tab. The connection properties are then displayed on the screen. 
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25. On the left part of the window displayed scroll down and select DTHSD 1 then on the 

right part of the window select Samples then click on Apply. Then click on the Calibration 

tab. The calibration properties will then be displayed on the screen. 

26. On the calibration window enter 0 in Units Low and 1000000 in Units High then enter 0 

in Bits Low and 1000000 in Bits High. Then Click on the Analogue Output Tab. The 

analogue output properties will then be displayed on the screen. 

27. On the Analogue Output window set Increment to 100 and Default Value to 1000 then 

click on Ok.  

28. Right click on the tile of the fourth box and select Properties. The properties window 

appears on the screen with the general properties displayed. 

29. Enter HSD Mode in the Description field, set the Units field to blank then left click on the 

grey box opposite Box Colour and select the red colour and then click on Ok. 

30. Click on In Use. 

31. Click on the Connection tab. The connection properties are then displayed on the screen. 

32. On the left part of the window displayed scroll down and select DTHSD 1 then on the 

right part of the window select Data Mode then click on Apply. Then click on the 

Calibration tab. The calibration properties will then be displayed on the screen. 

33. On the calibration window enter 1 in Units Low and 4 in Units High then enter 1 in Bits 

Low and 4 in Bits High. Then Click on the Analogue Output Tab. The analogue output 

properties will then be displayed on the screen. 

34. On the Analogue Output window set Increment to 1 and Default Value to 1 then click on 

Ok.  

35. Right click on the tile of the fifth box and select Properties. The properties window 

appears on the screen with the general properties displayed. 

36. Enter HSD Start in the Description field, set the Units field to blank then left click on the 

grey box opposite Box Colour and select the red colour and then click on Ok. 

37. Click on In Use. 

38. Click on the Connection tab. The connection properties are then displayed on the screen. 

39. On the left part of the window displayed scroll down and select DTHSD 1 then on the 

right part of the window scroll down and select Start then click on Apply. Then click on 

the Digital In/Out tab. The Digital properties will then be displayed on the screen. 

40. On the digital properties window leave Off Text blank set ON Text to RUN and set Default 

State to 0, select Momentary Action then click on Ok.  

Once the configuration file has been successfully modified the changes have to 

be saved by selecting in the File menu Save Setup. 
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Connections 

The terminal box connect to the J1 connector of the DT321 board with cable 

terminated by the 68 way D Type is illustrated below: 

 

  

The analogue output to be data logged connect to the front panel of the 

terminal box using the 8 BNC connectors labelled INPUT1 … INPUT 8. 

External trigger channel and encoder input connect to the back panel of the 

terminal box. The External trigger channel connects to the BNC connector. The 

signal connected to the external channel must be a TTL 0-5V signal. The 

encoder input allows connection of a TTL encoder. The pin layout of the 

connector is illustrated below: 

 

  

Pin 1 is connected to +5V output of the terminal box and can be used as a 

supply voltage for an encoder, Pin 2 is the ground signal. Pin 4 is connected to 

the external trigger input of the terminal box therefore channel A or Z of an 

encoder can be connected to this input to trigger an acquisition on encoder 

pulses. Pin 4 is also link to the external trigger BNC connector therefore no 

signal must be connected to the external trigger BNC input when signal is 

connected to pin 4 of the encoder input. 

Pin 5 is connected to Input 1 of the terminal box so either channel A or Z of an 

encoder can be connected to the analogue input to be data logged. No signal 

should be connected to the Input 1 BNC connector (on the front panel of the 
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terminal box) when a signal is connected to the pin 5 of the encoder input 

connector. 

Operation 

Once the software has been successfully set-up the main COMPEND window will 

be similar to the one displayed below, with DTHSD box displayed in the status 

bar with a green background and the five channels for Data Mode, Frequency, 

Samples, Channels and Start displayed in the main window: 

  

 

  

If the DTHSD box in the status window is not present or the background colour 

is NOT green check that the INI file is set-up correctly and that the board has 

been install successfully. If the problem persists, contact Phoenix Tribology for 

further assistance. 

The box HSD Channels is used to specify the number of channels to data log. 

Up to 8 channels can be recorded. The box HSD Samples is used to set the 

number of data points to be taken for every burst of high-speed data. The box 

HSD Frequency is used to set the sampling rate. The box HSD Start is used to 

start the high-speed acquisition. The box HSD Mode is used to set the type of 

high-speed data acquisition desired. There are four different modes. 

With Int Paced mode the high-speed acquisition is triggered as soon as HSD 

Start channel is activated with data acquisition at the frequency set in HSD 
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Frequency. The maximum sampling rate achievable is 250 kHz for 1 channel; 

the maximum sampling rate will decrease as the numbers of channel data log 

increases: 

  

Number of 

Channel 

Maximum 

Sampling 

Frequency 

1 250 kHz 

2 125 kHz 

3 83.3 kHz 

4 62.5 kHz 

5 50 kHz 

6 41.6 kHz 

7 35.7 kHz 

8 31.25 kHz 

 

Ext Trig Scan is identical to Int Paced except that the acquisition will not be 

triggered as soon as the HSD Start channel is activated. The acquisition will be 

triggered as soon as an external trigger signal is detected. This external signal 

can be connected to the back of the connection cabinet either on the External 

Trigger BNC connector or the encoder input on the 5-way DIN socket. This 

signal must be TTL type and will trigger the acquisition on a rising edge. 

With Ext Retrig, the acquisition is triggered by the HSD Start channel and the 

frequency set in HSD Frequency is ignored. Instead an external signal 

connected to either the external trigger connector or the encoder input is used 

as a sampling signal. This signal must be TTL type and will trigger on a rising 

edge.  

Ext Tg-Rtg is similar to the Ext Retrig mode except that the acquisition is not 

triggered by the HSD Start Channel but by an external trigger channel. 

When Ext Trig Scan, Ext Retrig or Ext Tg-Rtg mode are used the maximum 

sampling frequency that can be used also decreases as the number of channels 

data logged increases:  
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Number of 

Channel 

Maximum 

Sampling 

Frequency 

1 165 kHz 

2 99.5 kHz 

3 71.2 kHz 

4 55.4 kHz 

5 45.3 kHz 

6 38.3 kHz 

7 33.2 kHz 

8 29.3 kHz 

 

The frequency of the external trigger signal must not exceed the maximum 

sampling frequency. 

Once the Data logging is started the DTHSD box in the status bar changes 

colour from green to cyan, while the acquisition is active, and then from cyan to 

violet, while the data is transferring from memory to the data file. 

When the high-speed acquisition is activated manually from the COMPEND main 

screen using the HSD Start box the data is stored in the file DTHSD.tsv, located 

in the subdirectory DATA of the COMPENDX directory. 

Five more columns corresponding to the five set-up boxes of DTHSD are 

displayed in the TSF: 
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In the example displayed the test records high-speed data during Step 3, 

indicated by RUN in the HSD Start column. To select the RUN command, when 

editing the TSF, right click on the empty cell and tick the RUN option, then click 

on the Ok button: 

 

However, in order to be able to record data the DTHSD unit must first be set-

up. In this case this has been done in Step 1. 

  

Clicking on the Samples cell allows the user to set the desired number of 

samples (in this case 10000). The number of channels is selected by clicking on 

the number of channels cell and entering the required value. 
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Finally, clicking on the Frequency cell reveals a window containing the five 

available modes. Select the required mode and click the Ok button: 

 

Data are recorded into an ASCII file. The file name is automatically generated 

and hyperlink created in the main COMPEND data file.  

Advanced Set-up 

By changing parameters in the COMPEND INI file parameters such as input 

range and calibration may be modified. The INI file is read by COMPEND at 

start-up, thus any changes made to the INI file will only take effect when 

COMPEND is closed and restarted. 

Changes to the INI file should only be performed with advice from Phoenix 

Tribology as they may affect the functioning of the machine. The parameters 

affecting the High Speed Data Acquisition system are all displayed in the 

[HSD_ADC] group. 

The Gain parameter can be set for each individual channel. DT321 board 

provides gains of 1, 2, 4, and 8 and these can be set in the INI file. Effective 

ranges are as follows: 

 

GAIN INPUT RANGE 

1 ± 10V 

2 ± 5V 

4 ± 2.5V 

8 ± 1.25V 
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For each channel, choose the gain that has the smallest effective range for the 

signal you want to measure. For example, if the range of your analogue input 2 

signal is ±1.5 V, specify a gain of 4 for the channel 2 by writing GAIN2 = 4 in 

the INI file; the effective input range for this channel is then ± 2.5 V, which 

provides the best sampling accuracy for that channel. 

The calibration of each channel can also be modified, in the same way as a 

standard channel, by using the bypass calibration feature. However being a 16 

bit system the bit high value corresponding to the positive range is 65535 and 

the bit low value corresponding to the negative range is 0. 

When data is acquired manually from the main COMPEND window the data is 

stored in a file located in the data directory of COMPENDX. The name of the file 

is set by default to DTHSD. This name is set in the parameter DEFAULT_FILE in 

the INI file. 

By default the board is set to accept differential inputs. If single ended inputs 

are required set DIFFERENTIAL = FALSE in the INI file. 

When using a DTHSD channel in a Derived Channel Calculation, the resulting 

calculating channel will be added to the data recorded in the DTHSD file. 

High Speed Graph 

This is provided by a free-standing application installed in the main COMPEND 

application directory. It uses the same resources as COMPEND and is invoked 

from the Graph menu by selecting High Speed Graph. 

 

The application polls the COMPEND data directory once a second and looks for 

the presence of high-speed data files. A copy of the latest high-speed file, is 

read, analyzed and graphed. A range menu is provided for adjusting the scaling 

of each data channel displayed. 

The resulting graph is displayed on the screen and remains in view until 

updated by the next high-speed data file. 
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The graph may be printed and updating is suspended during the printing 

process. 

The graph is lost once updated, but the original data is of course retained in the 

relevant high-speed data file. 

By selecting the Setup menu and then Scale the scale of each individual 

channel can be set.  
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SUPERSLIM Interface Hardware 

General Description 

The Phoenix Tribology SUPERSLIM Serial Link Interface Module is a micro 

controller based multi channel and multi function interface, currently used as the 

core of a wide variety of standard Phoenix Tribology products. Its construction is 

motherboard format of a size compatible with standard 19 inch enclosures. 

SUPERSLIM can be supplied as a motherboard assembly with connections via DIN 

sockets mounted along one edge of the motherboard: 

1 32 4 51 8732 4 65

Signal

Signal

0 Volts

-12 Volts

Spare

+5 Volts

+12 Volts

Open/Blanked

Analogue Inputs Pulse Counting Inputs

Signal +

Signal -

0 Volts

+5/+12Volts

LED

8 Pin DIN Socket 5 Pin DIN Socket

 

Voltage Inputs:    Pin 1 -ve 

   Pin 2 +ve 

Current Inputs: Self Powered:  Pin 1 +ve 

   Pin 2 -ve 

Externally Powered: Pin 1 -ve 
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   Pin 2 +ve 
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Technical Specification 

Control frequency up to 10 Hz. 

Maximum internal data acquisition rate 10 kHz. 

Serial data transfer rate 100 channels per second. 

Up to 10 operating protocol commands from high level language per second. 

Up to 640 kByte on board memory available in 128 kByte blocks either as RAM or 

FLASH ROM. 

Eight 12 bit resolution Analogue Inputs individually configurable for 0-5V, +/-5V, 

0-10V, +/-10V, (self-powered) 4-20mA ranges. 

Two 16 bit resolution, opto-isolated, 60 pulse/rev magnetic pick-up RPM 

Counters.  

Programmable high and low level alarms on all analogue and pulse counting 

inputs. 

Four 12 bit resolution Analogue Outputs individually configurable for 0-5v, +-5V, 

0-10V, +-10V, (self-powered) 4-20mA ranges. 

Each output has a programmable ramp with initial set value, final set value, start 

and hold. 

Four PWM Digital Outputs with individually configurable duty cycle and power 

limits. 

PWM outputs operate in parallel with the analogue outputs. 

Four independent PID controllers with full auto-tune, selectable cycle time and 

output clamps. 

Remote analogue set-points selectable on all four PIDs. 

Feedback source selectable from any analogue or pulse counting input on all four 

PIDs. 

User selectable digital smoothing on all analogue and pulse counting inputs. 

Four opto-isolated Digital Inputs which will accept DC or AC input voltages up to 

240V. 

Four clean-contact changeover relay outputs. 
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RS232 primary and secondary serial ports (38400 baud maximum) enabling up to 

four SUPERSLIM units to be controlled from a single PC. 

 

 

 

 


